
NEWSLETTER #91 - June 2020

Big news, big newsletter this month! It’s so big it’s put our Desktop 
Publishing team into meltdown, never mind pandemic lockdown.

Our big news – we get to finally announce this year’s Excel Summit – and it’s available to EVERYONE!!  At the time of writing, we have no 
less than 46 Excel experts confirmed for our Excel Virtually Global conference.  By our reckoning, that’s the largest public collection of Excel 
experts ever.  And it costs next to nothing to attend.  And with it online, with live and recorded options, you have no excuse not to join!

And it’s a big newsletter too – thanks in part to us having to go through no less than two Power BI Desktop updates.  Tolstoy would be 
proud of us.

There’s other news as well, including a free three-way integrated financial model (and information on a Power BI variant), information on 
Power BI datasets, an update to Microsoft Information Protection, new names for the update channels, a new sheet tab icon for Excel, 
updates for Excel for Mac and belated news of a significant “tweak” to the calculation engine in Excel.

But there’s even more in this month’s bursting-at-the-seams newsletter: Beat the Boredom, Visual Basics, Power Pivot Principles, Power 
Query Pointers, A to Z of Excel Functions (Euro Convert if you like this month’s offerings!), Keyboard Shortcuts et al.

By the time you’ve read this month’s newsletter it will be July.  We hope it takes your mind off the current state of the 
world.

Stay safe, stay happy, stay healthy.

Until next month.

Excel Virtually Global
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Liam Bastick, Managing Director, SumProduct

Microsoft’s Most Valuable Professionals, or MVPs, are technology experts 
who passionately share their knowledge with the community.  They are 
always on the “bleeding edge” and have an unstoppable urge to get their 
hands on new, exciting technologies. 

How much would you be prepared to pay for the likes of Excel (and 
other) MVPs, Microsoft staff and other industry experts, such as David 
Abiola, Jon Acampora, Matt Allington, Indira Bandari, Medha Bandari, 
Liam Bastick, David Benaim, Yolanda Cuesta, Govert van Drimmelen, 
Purna Chandra Rao Duggirala, Imke Feldmann, Leila Gharani, Jordan 

Goldmeier, Richard Goring, Roger Govier, Frederic le Guen, Ingeborg 
Hawighorst, Tim Heng, Wyn Hopkins, Boris Hristov, Bill Jelen, Tony de 
Jonker, Gasper Kamensek, Jeff Lenning, John MacDougall, Nabil Mourad, 
Patrick O'Beirne, Dave Paradi, Keyur Patel, Jon Peltier, Boriana Petrova, 
Jan Karel Pieterse, Ken Puls, Reza Rad, Sudhi Ramamurthy, Tony Roberts, 
Raphael Santos, Rishi Sapra, Glenna Shaw, Oz du Soleil, Grzegorz Stolecki, 
Echo Swinford, Alessandro Trovato, Henk Vlootman, Charles Williams 
and Qinglin Zhou to present on a variety of Excel topics in your house?

Not everyone in this picture will be presenting – but a lot of them will be!
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Well, it’s an option.  Our usual Excel Summit South will not be held this 
year due to the COVID-19 pandemic.  But we won’t we be beaten.  We’ll 
just go bigger.  And better.  And global.  And cheaper.  And it’s for charity.

This two-and-a-bit-day virtual conference, now in its fifth year, presents 
Excel, Data Platform and PowerPoint MVPs, together with other 
acknowledged experts from Microsoft and / or around the globe to 
present, answer questions and demonstrate the future of Excel and 
how it will make your life easier, personally and professionally.

Topics for the 53 sessions will include: Auditing Spreadsheets, Charts, 
Dashboards, Data Analysis, Data Types, Dynamic Arrays, Excel Tricks 
& Tips, Financial Modelling, Forecasting, Maps, Microsoft 365, New 
Functions and Features, PivotTables, Power BI, Power Pivot, Power 
Query, Presenting Your Data, Spilled Formulae, Testing, Timelines and 
VBA. And note well – it’s not all in English, with sessions in Mandarin, 
Portuguese, Spanish and Telugu, as well.

Each session (including Q&A) will last no more than an hour and topics 
cover all expertise levels, from novice to expert.  Most presenters are 
well known in their spheres, and have written blogs, books and articles 
and / or present video sessions.

Most sessions will be recorded so you may watch them later with 
downloads aplenty – there are no medals for staying up to watch the 
entire event live!  That’s just as well, as it will run from 19:00 GMT / UTC 
on Tuesday 21 July to 23:59 GMT / UTC on Thursday 23 July.  What do 
these marathon runners know about marathons?  We’re planning a Tour 
de Excel.  (Yes, I know it should be d’Excel, but you get the gist!)

From your own favourite chair, bring a laptop, an inquisitive mind and 
your sense of humour. Be prepared to learn heaps. And remember, it’s 
not just value for money, it's for charity – all profits will be donated to a 
global COVID-19 research charity.

For more details (e.g. times, speakers, sessions), please go to  
www.excelvirtuallyglobal.com and register at https://www.
eventbrite.com/e/excel-virtually-global-a-virtual-excel-summit-
tickets-106319837496.

Hopefully, we’ll see you there!

Three-Way Integrated Financial Models Offer
We know that everyone all over the world has been going through a fairly 
tough time with isolation and social distancing.  We know how important 
it is to maintain these measures in order to keep everyone safe from the 
coronavirus.  

With isolation laws in place, many businesses have had to go through 
some form of restructuring, be it selling products at a different stage 
of production or changing the entire operation of the company.  Cash 
flows have suffered too, as everyone has tightened their proverbial belts.  

These changes require analysis of the company’s financial statements, 
both actual and forecast, before making any decisions.  To help our 
readers, we have decided to give out a free copy of a three-way integrated 
financial model in Excel.

You can find a copy of the file at:  
https://sumproduct-4634.kxcdn.com/fileadmin/filemount/news_
graphics/Free_Excel_File___PBI_bait/SP_Simple_Example_Financial_
Statement_Model.xlsx.

Hopefully, you will find this file useful.  Please note that it is a simple three-
way integrated financial model, it contains generic input assumptions 
that applies to many businesses, but it’s not perfect and it is simplistic.  
Our normal models are more sophisticated, but you get the general idea.

We hope this will be beneficial: a user will have to add inputs and 
possibly adapt the model further before it should be used in a business, 
but it’s better than a blank Excel worksheet.  And please remember, we 
do not warrant that the model is free from mathematical error and / or 
accounting accuracy, so caveat emptor!

But there’s more.

Apart from three-way integrated financial models in Excel, we are also 
proud to announce that we will be offering a new service where we 
will build the same three-way integrated financial models in Power BI.  
We know some of our competitors are offering similar products, but 
we believe we are the only company to offer to construct the financials 
completely in Power BI, rather than import the statements from 
elsewhere (obviously, we still need to bring the source data in!).
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Building such models in Power BI offers greater flexibility for end users.  With a reporting dashboard created in Power BI, depending on the complexity 
of the data, end users will be able to slice and dice the data at any level in any way they want.  They will also be able to flex certain inputs and see live 
dynamic changes to their bottom line when variables are altered.  

If you are interested in learning more, please reach out to us at contact@sumproduct.com.  

Beat the Boredom Challenge
With many of us currently “working from home” / quarantined, there are only so Zoom / Teams calls you can make before you reach your data limit.  
Perhaps they should measure data allowance in mugs of coffee.  To try and keep our readers engaged, we will continue to reproduce some of our 
popular Final Friday Fix challenges from yesteryear in this and upcoming newsletters.  One suggested solution may be found later in this newsletter.  
Here’s this month’s…

If there’s one thing that can be tedious in Excel, it’s creating a variance report.  Imagine you had originally created a budget and as more information 
came to light, you decided to revise the numbers as follows:

That’s easy enough, right?  Put the original budget in the first line and the reforecast data in the second line et voila! you can produce your variance 
analysis in the bottom row.

But that’s not how management want it.  They want it to look like this:

It’s all well and good, but that means a different formula in each cell:

Yuck.  That means plenty of opportunities to reference the wrong cell as well as making it impossible to copy the calculation across the row.  
Thousands of accountants face this thankless task every day – this report can be ridiculously time-consuming and is so easy to calculate incorrectly 
or misreference.  Is there a better way?
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All you have to do is reproduce the above example and write a formula in cell E14 (the first calculation) that may be copied across the entire row of 
the Report Table. 

Sound easy?  Try it.  One solution may be found later in this newsletter – but no reading ahead!  

You may also analyse Power BI datasets in Excel using PivotTables:

As well as Data Types, Microsoft has also added the ability for PivotTables 
connected to datasets stored in Power BI to be created in Excel, allowing 
you to continue to work in Excel.  This new capability creates a live 
connection to the underlying dataset in Power BI, meaning updates 
within the source are published to the reports connected to it.  

It should also be noted that Excel PivotTables also respect the Microsoft 
Information Protection (MIP) Sensitivity labels (see below) applied to the 

file when the PivotTable was created.  Therefore, since Excel may now 
promote the adoption of certified datasets within your organisation, 
this can help with version control surrounding your data, when making 
critical decisions in your business.

These new capabilities will start rolling out to Office Insiders later this 
year.  Watch this space.

Coming Soon: Power BI Datasets in Excel
Last month it was announced that Microsoft is introducing two new ways 
to access Power BI data from within Excel:
	 1.		 Excel Data Types
	 2.		 through PivotTables connected directly to Power BI. 

It’s been a common gripe amongst users for quite some time as to how 
to get Power BI datasets (back) into Excel.  Analyze in Excel may be one 
way, but now with the click of a button, users may now discover Power BI 

datasets without having to go via Power BI.  By using Power BI certified 
and promoted dataset capabilities, users now have easier access to 
relevant and refreshable data.

Using Data Types, you can quickly find details from featured tables in 
Power BI datasets within Excel’s data types gallery.  Data Types gives you 
the flexibility to organise information in any way you want within the 
Excel grid.  This allows you to use formulae, build reports and analyse 
your data in the good ol’ fashioned spreadsheet way.
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Coming Soon: Microsoft Information Protection (MIP)

Tell Me, Now in Excel for Mac

Data From Picture in Excel for Mac

Not only available in Excel, but also in both Power BI and other Office 
products, Sensitivity labels from the Microsoft Information Protection 
framework are already available (indeed, we wrote about them back in 
September 2019), allowing you to classify and protect your organisation's 
data whilst making sure productivity and collaboration are unhindered. 

These labels will persist when applied from Power BI content and 
exported to Excel, PowerPoint and / or PDF files.  However, this feature 
will shortly take a step further.  When you connect to a Power BI dataset 
from Excel, that dataset's Sensitivity label will be inherited and applied 
to the Excel file and all associated outcomes, such as headers, footers 
and encryption.

The ‘Tell Me’ feature allows Mac users to enter words and phrases about 
what you want to do next.  It then suggests the tools, features and / or 
functions you want, in order to use or perform the action(s) you require.  
It may also be used to get additional help with a task.

You can find the Tell Me feature to the right of the light bulb in Excel 
(it’s also in Word and PowerPoint).  Simply click it and type what you’re 
looking to do.

And there’s more.  ‘Data From Picture’ in Excel for Mac allows you to turn images with table data into real data you can edit in Excel.  This may use a 
screen clipping, an image already stored or from an iPhone camera, for example.

To use ‘Data From Picture’, first you need to capture the content you want to digitise, e.g.

	 •	 select Insert -> Data From Picture -> Picture From File:

	 •	 copy an image of a table to your clipboard, say, by taking a screenshot of a table by pressing SHIFT + CMD + CTRL + 4, and then select Insert -> 	
		  Data From Picture -> Picture From Clipboard

	 •	 right-click a cell, and select ‘Scan Documents’ (this requires an iPhone configured to use Continuity Camera).  Make sure you have good 	
	 	 lighting and focus on the data, and then tap the button to take the picture.  If you’re satisfied, tap the Save button to send it to Excel.

This feature is available to Office 365 subscribers on Insider (shouldn’t that be Beta now?) build 16.36 (20041300) or later.

This new, more rigorous integration between Excel and Power BI will provide users with more information protection in Excel’s familiar and easy to 
use interface, all with fewer clicks. 

This update will also start rolling out to Office Insiders later this year.

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

After you have captured the picture of the content you want to bring into Excel, the ‘Data From Picture’ dialog box opens and shows the progress as 
the image is being analysed.  The results generated should be reviewed and amended as necessary.  Then, select ‘Insert Data’.

There are several scenarios that come to mind readily:

	 •	 Scan some data from a book or magazine (subject to copyright, obviously!)

	 •	 Screen capture a table from a website

	 •	 Take a picture of some printed data. 

This feature is also available to Office 365 subscribers that are Insider (Beta) users on version 16.36 or greater.

New Update Channels
We covered the recent announcements about Office 365 being renamed 
in last time’s newsletter.  That caused a little commotion, so I thought I 
would try and upset you all a little more this month…

Recently, Microsoft has announced a new update channel, the Monthly 
Enterprise Channel, in response to those who wanted to use the Current 
channel but with just a little more “predictability”.  This came into effect 
from 12 May.

Furthermore, from 9 June, new Office / Microsoft tenants will be provided 

with a new default channel – instead of the Semi-Annual Enterprise 
channel, the default update channel for Enterprise will be the Current 
channel.  This will NOT cause any changes for existing tenants.

But it gets better.

Additionally, on June 9, Microsoft is also updating the names of the 
existing update channels “…to offer admins (sic) more clarity into our 
servicing strategy…”:

Old Name New Name

- Monthly Enterprise Channel

Insider Beta Channel

Monthly Channel (Targeted) Current Channel (Preview)

Monthly Channel Current Channel

Semi-Annual Channel (Targeted) Semi-Annual Enterprise Channel (Preview)

Semi-Annual Channel Semi-Annual Enterprise Channel
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If you use an automatic deployment rule (ADR) to deploy updates, by using Configuration Manager, you may need to make changes due to the 
update channel name changes.  Microsoft advises that any ADR changes should be made after June 9.

You may want to update your organisation content and documentation to reflect this change.

Let the street parties start now, COVID-19 restrictions notwithstanding.

New Protected Sheet Icon

You Might Need to Read the Manual for Automatic Calculations

Visual Basics

For those in the Office 365 Insider channel (now called the Microsoft 365 Beta channel, if you are keeping up to date with the last two newsletters!), 
there’s a new icon for your sheet tabs:

It actually occurred with little to no fanfare a while ago, but Microsoft has 
“…made a little tweak…” to how Excel saves the calculation setting, so 
that manual calculation settings don’t cause so much disruption when you 
have several workbooks open together and decide to save one or more. 

The software giant has changed the settings so that Excel should only 

change a workbook’s saved calculation mode if you set it yourself during 
that session.  Therefore, if you don’t touch the calculation mode setting, 
it will retain the original calculation state for each workbook.  That’s 
great news and stops the proliferation of manually calculating workbooks 
propagating through an organisation.

We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month, we look at creating loops.

See the small padlock icon?  If you protect your worksheet (Home -> Format -> Protect Sheet… or ALT + T + P + P), you will see this image.  Now, if 
you password protect your workbook and then forget your password, well, that’s a different story…

For example, consider two workbooks, Manual, set to manual calculation setting and Auto, set to automatic calculation setting:

	 •	 open Manual
	 •	 this causes Excel to be in manual calculation mode
	 •	 Open Auto
	 •	 Excel stays in manual calculation mode
	 •	 save Auto
	 •	 Excel no longer sets the calculation mode in Auto to manual (it would have done in the past!).

That’s going to save a lot of unknowing heartache…
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Last month, we showed you how to declare variables.  This time, we’re going to use a variable to create a loop.  Let’s introduce the For loop.

The basics of the For loop involve taking a variable, incrementing it until it gets to a certain target number, and performing a bit of code for each 
incremental step.  It looks a bit like this:

For X = 1 to 10

<Do this code for each of the 10 times>

Next X

We can use this to put together a simple example that counts the number of coin flips land Heads when we flip them 10 times.  Let’s combine a few of 
the things that we’ve learned.  If you like, you can copy the text below into VBA, or type it out yourself.

Sub FlipCoins()

Dim X as Integer

‘Declare an integer that will be incremented

Dim Heads as Integer

‘Declare a variable that will store the number of times a coin lands as Heads

Heads = 0

‘Set the initial value for the counter to be zero

For X = 1 to 10

If Rnd() >= 0.5 Then Heads = Heads + 1

‘Take a random number between 0 and 1.  If the value is greater than or equal to 0.5, then add one to 
the Heads counter.

Next X

MsgBox “You flipped” & Heads & “Heads over 10 coin flips.  Well done!”

End Sub

Have fun flipping coins.  More next time!

Power Pivot Principles
We continue our series on the Excel COM add-in, Power Pivot.  This month, we look at negating formulae in Power Pivot.

You may recall that previously we were creating a measure that calculated refunds.  Let’s now consider that we want to have that measure be negated.  
To do this, go to the ‘Power Pivot’ tab on the Ribbon and then click on the Measures drop-down menu:
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The ‘Manage Measures’ dialog box will appear, allowing us to select the ‘Refunds’ measure.  Next, select the ‘Edit’ button:

The ‘Refund’ measure will appear, where we can add a negative operator in-front of the formula viz.

On some occasions, negating the formula via this method does not seem to work DAX.  Further the minus sign – straight after the equals sign – can 
easily be missed by the unwary.  There is a simple, safer option: multiply the entire formula by negative 1 instead:

More Power Pivot Principles next month.
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Get Data From PDF

Office Insider / Beta Channel File Opening Issue Workaround

For all the perennial whingeing we do about changes to Excel, Office and Windows, sometimes it’s just great to see new stuff emanate.

Here is one such example.  Without doubt, one of the most common questions we ever get at SumProduct is, “how do I extract data from a PDF file?  
Do you have any good software recommendations?”.

Well – look at this:

Now I know not everyone uses Office 365 / Microsoft 365 / whatever 
it’s going to be called next week.  And I know even fewer use the Insider 
/ Beta channel.  But just in case you do, there seems to be a problem 
for some of us (not everyone) with installing the latest Windows and 
Microsoft 365 updates.

You may find yourself trying to open a file directly from email or from 
a website and be confronted with one of these two messages – either:

It’s frustrating, but fellow Excel MVP David Benaim has come up with a way around this problem.

Rather than try to open the file directly, save the file instead.  Then, go into File Explorer (Windows Key + E) and right-click on the saved file and access 
the Properties dialog:

or:

The latest release of The Artist Formerly Known as Office 365 Excel Insider 
(Fast) – and now Microsoft 365 Excel Beta Channel – has now gone out 
and beta’d itself.  Power Query / Get & Transform has a new buddy, Get 
Data From PDF.  There will be cheering from the rooftops for this one.

Only in the 365 Beta version presently, you may access this feature by 
going to Data -> Get Data -> From File -> From PDF (ALT + A + PN + F + 
P).  We don’t know how well it works yet – hey, this is hot off the press 
– but it’s a start!
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On the first tab, General, at the bottom you may note a new ‘Security:’ 
section, explaining that the offending file came from another computer 
and may have caught the coronavirus.  To access it, you will need to tick 
the Unblock checkbox.

Whilst it’s great that Microsoft is out there trying to save us from 
ourselves, it may get a little tedious if you have 200 files to download.  
There is a ‘global’ workaround, BUT WE DO NOT RECOMMEND IT AN 
URGE YOU NOT TO “FIX” THE SITUATION THIS WAY.

But, just in case you need to – and you know what the ramifications of 
the following are – this situation may be avoided as follows.

The issue appears to originate from ‘Protected View’.  As a reminder, an 

Office document that opens in ‘Protected View’ mode cannot be edited 
until you acknowledge some sort of trust of the source of this document.  
To do this, you need to click the ‘Enable editing’ button upon opening 
so that you can edit the document.  However, this is usually temporary.  
Next time you open the document, it may still open in ‘Protected View’ 
mode.  

With this borne in mind, to counter our above issue for Excel files (for 
other Office products, the idea is similar), you could take the following 
ill-advised steps:
	 •	 Select File -> Options in Excel and select the final option in the left-	
		  hand column, ‘Trust Center’

	 •	 Click the ‘Trust Center Settings…’ button
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	 •	 In the resulting dialog, select ‘Protected View’ from the left-hand column and then de-select the first three checkboxes in the main pane to 	
	 	 disable ‘Protected View’

	 •	 Once these have been de-selected, click OK

Your problems for opening files directly from the internet or email should 
now go away, but you may have created more problems than you have 
solved!

I can’t stress enough how much I DON’T recommend this option.  If 
you do have to do it to open numerous files, do remember to re-enable 
‘Protected View’ afterwards.

It is noticeable that Microsoft is on the ball with this particular issue.  I 
suspect this one might be remedied very quickly.  This is what tends to 
happen when you try Beta versions of software.  Personally, I like seeing 
these new ideas.  Of course, there will be glitches, but as long as they 
don’t fry my hard drive, personally, I am happy to take the rough with the 
smooth.  This is just a bit of rough!

Power Query Pointers
Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, we look at 
how to merge queries to compare two similar lists.

Sometimes, the tasks we have to do are less than thrilling.  For example, you could be given two long lists of employees, and told to find who is missing 
from each list:
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With Power Query, there is an easy way to do this. 

We have two lists of employees which look virtually identical, but of course they are not.  The first step to take is to use Power Query to load the lists.  
Let’s begin by creating our first query.

On the ‘POWER QUERY’ tab (in Excel 2013, else the ‘Get & Transform’ 
section of the Data tab on the Ribbon), let’s use the ‘From Table / Range’ 
option in the ‘Excel Data’ section.  You may either convert the data into 

a Table before you use this option or else let Power Query do this as part 
of the query creation.

Our data appears in a new query, which we will call ‘Employee Table 1’.  Choose the ‘Close and Load to’ option on the ‘Close and Load’ section on the 
Home tab.
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We only want to create the connection as we are going to use these queries for comparison.  Having created the first query, we will repeat the process 
for the second employee list. 

Our next step is to merge these queries.  To do this, we can right-click on one of the employee queries (else use the option from the Combine section 
of the ‘POWER QUERY’ tab).

Select the Merge option.
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In the ‘Merge’ screen, we will specify the second employee table, and 
then we will see a preview of the data in both queries.  We want to merge 
these tables completely, so select all columns in both tables.

At the bottom of the screen we have the option to specify the ‘Join Kind’, 
and this will determine what data I see when the queries are merged.  

Here, we are interested in the joins that will either find our matching or 
missing data, which are the last three on the drop down.  

Let’s go through several of these options now.

This will give us those employees that are on both lists.  Pick this option first.

The rows we can see initially are those rows which match the criteria in the first table, and I have an extra column which is labelled ‘Employee Table 
2’, which contains a table.  Choose to expand the second table to see which rows match the criteria in the second table:

We don’t need to use any original column names as a prefix, so uncheck that box and choose ‘OK’.

‘Inner’ 
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I have 42 employees in both tables. 

Let’s opt to merge my tables again, and this time we will pick join type ‘Left Anti’.

This time, we are interested in the first table, since this will show us those employees in ‘Employee Table 1’ who are missing from ‘Employee Table 2’.  
We find four employees and two seem a little familiar…  Notice Zoe, as she’ll come up again later…

Just to show that the second table will be empty (as we are looking for employees that don’t appear here), we may expand the table viz.

‘Left Anti’ 
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The last final choice we will look at here is to create a merge with a ‘Right Anti’ join.  In the Power Query Editor, this looks a little strange before we 
expand the table:

This is because we are seeing the results from the first table, and since we are looking for values that are in the second table and not in the first table, 
it is empty.  Further, if we choose to expand the second table:

We see we have two employees that are missing from the first table – and it wouldn’t take too much investigation to discover that Zoe has changed 
her name from Green to Brown!

More next month!

‘Right Anti’

Power BI Desktop Latest Updates
You may have noticed the usual monthly Power BI Desktop updates were 
missing from last month’s newsletter.  This is because they were delayed, 
in order to be announced at the virtual Microsoft Business Applications 
Summit (MBAS) instead, which was held on Wednesday, 6 May.  If you 
missed it, you can check out some of the highlights at https://www.
microsoft.com/en-us/businessapplicationssummit.

So we’ve doubled up this month!  Anyway, there were the usual 
multitude of updates (times two!), including a new visual personalisation 
feature to allow end-users to explore and customise visuals all within the 
consumption view of a report.  But that wasn’t all: if you’re interested in 
fast refresh scenarios, these were accommodated too.

Further, it was announced that in light of the current COVID-19 pandemic, 
Microsoft has decided to give more flexibility by providing an additional 
month for users to move over to the modern filter experience before 
all reports in Power BI Desktop and Power BI Service are automatically 
migrated.  Therefore, users had a little more time to update your reports 
so you can tweak / customise any of the Filter pane formatting before 
your reports were scheduled for an auto-upgrade in May.  Given the 
printing deadlines for this newsletter, we cannot be sure this has actually 
occurred, as at the time of writing.
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Reporting

	 •	 Personalize visuals (Preview)
	 •	Change detection for page refresh (Preview)
	 •	Relative time filter (Preview)
	 •	 Rectangular lasso select across visuals
	 •	 Conditional formatting for totals and subtotals in table and matrix
	 •	 Customize theme dialog is now Generally Available
	 •	 Improved discoverability for conditional formatting
	 •	Curate featured tables for Excel (Preview)
	 •	Apply all filters (Preview)
	 •	 Enhancements to change detection (Preview)
	 	 	 o	 Change detection simulation in Power BI Desktop
	 	 	 o	 Change detection queries in Performance Analyzer

Analytics

	 •	 Direct Query support for AI visuals:
	 	 	 o	 Decomposition tree
	 	 	 o	 Key influencers
	 •	Decomposition tree now supports ToolTips
	 •	Decomposition tree is now Generally Available
	 •	 Q&A updates:
	 	 	 o	 Suggest questions
	 	 	 o	 Teach Q&A now supports measure conditions
	 	 	 o	 Q&A is now supported on Power BI datasets

Template Applications

	 •	 Power Platform Center of Excellence StartKit
	 •	Azure Cognitive Search: analyze logs and metrics
	 •	 COVID-19 Apps

Modelling

	 •	 List separator and decimal symbol will now default to the standard 	
		  DAX separators

Visualisations

	 •	 Radar/Polar chart by xViz
	 •	 Comicgen by Gramener
	 •	 Pareto by sio2Graphs
	 •	 Growth Rate Combo Chart by Djeeni
	 •	 Smart Filter Pro by OKViz
	 •	New Visualization icons
	 •	 Packed bubble chart by xViz
	 •	Updates to hierarchy filter by xViz
	 •	 Power Apps visual is now compatible with all languages supported 	
		  in Power BI

	 •	Drill through button action is now Generally Available
	 	 	 o	 Conditionally set the drill through destination
	 	 	 o	 Conditionally format disabled and enabled state ToolTips
	 	 	 o	 Customise formatting for the disabled state
	 •	 Enhancements to page navigation action
	 	 	 o	 Conditionally set the navigation destination
	 	 	 o	 Support for shapes and images
	 •	Buttons now support fill images
	 •	Drop shadow support for visuals
	 •	 Filter pane migration

In any case, here’s the full list of updates:
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	 •	 Enhancements to Query Diagnostics
	 •	Direct Query on Dataflows
	 •	Web by example now automatically suggests tables by default
	 •	 Enhancements to Query Diagnostics: Privacy Level partitions

Previously, the way you could explore and modify the properties of a 
visual was by being in the full-editing experience (which can be quite 
foreign or not an option to many end-users without edit access), else 
have the report author duplicate the visual, make the requested 
modifications, and save it as a report bookmark.

That has now changed.  With this update, you can empower your end 
users to explore and personalise visuals all within the consumption view 
of a report.

Data Preparation

	 •	 CDM Folder view for Azure Data Lake Storage Gen2
	 •	Witivio connector
	 •	 Linkar connector
	 •	Webtrends connector
	 •	 Planview ProjectPlace connector
	 •	 Shortcuts Business Insights connector
	 •	Vessel Insights connector
	 •	 Zoho Creator connector

Data Connectivity

	 •	 New instructor-led training
	 •	 Dataset impact analysis.

Let’s take a look at each in turn.

Other

Personalize visuals (Preview)

Using this feature, your end users may explore a visual in many ways:

	 •	 change the visualisation type
	 •	 swap out a measure or dimension
	 •	 add or remove a legend
	 •	 compare two or more different measures
	 •	 	 change aggregations, etc.

Not only does this feature allow for new exploration capabilities, but it also includes ways for end users to capture, share and revert / restore their 
changes:
	 •	 capture their changes
	 •	 share their changes
	 •	 reset all their changes to a report
	 •	 reset all their changes to a visual
	 •	 clear out their recent changes.

Since this feature is in Preview, you will need to first turn on the feature switch by going to File -> Options and Settings -> Options -> Preview feature 
and make sure ‘Personalize visuals’ is turned on:
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After you turn on the Preview switch, you will need to specifically enable it for the reports that you want end users to be able to personalise visuals for.

To enable the feature on in Power BI Desktop, you will need to go to File -> Options and Settings -> Options -> Report settings for the CURRENT FILE 
and make sure ‘Personalize visuals (preview)’ is turned on.

When you enable this setting for a given report, all visuals in that report will have this on by default.  If you want to customise which visuals have this 
experience, you can toggle on / off this setting per visual in the visual header section of the Formatting pane:
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There is now a new option for automatic page refresh, so that your 
page refresh is based on change detection rather than a specific refresh 
interval.  We have been looking forward to this one.  For frequent refresh 
scenarios, it can be very inefficient to continuously send all queries to the 
source, especially if the data has not even changed.  

For example, if you are monitoring tweets, these might come into your 
model very often or between longer periods of time.  If you query the 

data source in a constant, frequent interval, it may result in unnecessary 
queries and expensive resource usage.  A better approach would be to 
have a query that runs in the background to check if data has changed 
and only refresh your entire report page if a change has been detected.  
Therefore, with this release, a new Change detection option has been 
added to specify how Power BI should query for changes to your Direct 
Query source, specifically, which measure should be evaluated and how 
frequently changes to that measure should be checked for.

Change detection for page refresh (Preview)
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To enable this feature, again, you will need to first turn on the ‘Automatic Page Refresh preview’ switch in the Options dialog:

After you have turned on the Preview switch, there are several ways to access this new capability: 

	 •	 go to the Modeling section in the Ribbon and select ‘Change detection’

	 •	 right-click in the field list and select ‘Change detection’ for the same outcome
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	 •	 go to the ‘Page Formatting’ pane and select ‘Add change detection’ in the page refresh section.

Authors have two options to create a change detection measure.  You can

	 1.	 choose one that is already in their model
	 2.	 create a new one based on common scenarios, such as latest date or count of rows. 

Finally, you will need to specify how frequently we should check for changes to that measure.

Once this is done in Desktop, you can publish the report to Power BI Service.  Change detection will only work if the report is published to a Premium 
workspace and the feature is enabled in the Premium capacity.  Also, since administrators can define the minimum interval allowed for change 
detection, Power BI will respect that minimum even if the author set up a more frequent interval to check for data changes.

For clarity and summary, here are important considerations for this new capability:

	 •	 only DirectQuery sources are supported
	 •	 you are only allowed to specify one change detection measure per model
	 •	 in Desktop, when you set up change detection, visuals will not refresh.  You will have to publish to the Service for page refresh to work, which 	
		  includes re-authenticating with the same credentials for refresh
	 •	 This is a Premium only feature unfortunately
	 •	 Premium capacity administrators must turn this on in the admin portal.
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Microsoft has recognised the need to filter to a smaller window of time has become a very popular request.  In response, they have announced a new 
type of filter: relative time filter.

When the filter is applied to the page / report level, all visuals under that level are synchronised to the same time range.

This ‘Relative time filter’ is in Preview, so, yet again, you will need to make sure you turn it in the Options dialog:

You do not have to use the feature in conjunction with ‘Automatic Page Refresh’; however, many of your relative time scenarios will pair best with the 
automatic or ‘Change detection’ page refresh feature.

With this new filter type, you will have the option to filter based on Last, Next or This time period for any datetime column in UTC:

Relative time filter (Preview)
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You will be able to specify the time period to be in Minutes or Hours:

If you need to save reporting real estate, you can also create the relative time filter as a Filter card in the Filter pane:

You can now select your visuals and other report elements by clicking 
and dragging over the canvas to create a rectangular lasso.  All visuals 
that are entirely encapsulated within the lasso will be selected.  If you 
are holding down CTRL or SHIFT (as you would multi-select by CTRL + 

clicking individual visuals), further lassoing will add visual selections to 
the current multi-selection.  If a visual is already selected and is lassoed, 
it toggles off that selection.  The lasso will not select single visuals within 
groups but can select groups by encapsulating the entire group.

It should be noted that the canvas will not automatically scroll with your rectangular lasso selection, which is a little bit of a pain.  This should only 
affect authors whose report pages are larger than the canvases on their screen.

Rectangular lasso select across visuals
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At last!!  Members of the team are whooping for joy, shouting from the rooftops with this update.  Conditional formatting for totals and subtotals has 
finally come to tables and matrices.  Yay!

The new theme dialog is now Generally Available.  Let’s revisit the details for all the updates to the ‘Customize theme’ dialog.

If you customise a theme in the theme dialog, an icon will represent that 
custom theme in a separate section in the theme dialog.  This icon will 
update whenever you customise your theme.  If you hover over the icon, 

a ToolTip will show up that explains that the theme is a custom theme.  If 
you define a theme name, it will also show up in parentheses.

Do bear in mind that the custom theme section currently holds a history of one theme, and if you customise a theme in the theme dialog, those 
changes will not be saved to your custom theme until you save your theme in the dialog.

Yes, you can now apply conditional formatting rules to your totals and subtotals in table and matrix visuals.  You will be able to find this new option 
in the ‘Apply to’ dropdown in the conditional formatting advanced controls dialog.  This feature will work for setting background colour, font colour, 
icons and web URL.

Keep in mind that you will have to manually set the thresholds or ranges 
for your conditional formatting rules, and that for matrices, Values will 
still refer to the lowest visible level of the matrix hierarchy.

This is something I know many of our readers / clients have been asking 
for too, and Microsoft has observed that the capabilities added today 
won’t cover every eventuality.  However, Microsoft has gone on record 

stating that they “…have got (sic) more planned for this feature, but we 
hope our current solution addresses some of your more basic needs…”.  
Hey, it’s a start!

The best way to improve / modify this feature is to ensure that you send 
Microsoft regular feedback on this feature so that they can modify this 
latest most welcome addition.

Conditional formatting for totals and subtotals in table and matrix

Customize theme dialog is now Generally Available

CUSTOM THEME SECTION
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Previously, there was an ‘Export current theme’ option in the theme dropdown.  This text has been updated to ‘Save current theme’.  You MAY use 
this option to save a theme in a JSON file.

If you adopt one of the older Power BI themes (Classic, City Park, 
Classroom, Color Blind Safe, Electric, High Contrast, Sunset or Twilight), 
you may have noticed that text formatting options were disabled.  Now, 

you can upgrade your base theme right in the report themes dialog to 
activate these text styling options.  Again, remember that you need to 
save your theme.

SAVE CURRENT THEME

UPDATE BASE THEME

Now that conditional formatting is available for a wider array of objects 
(like visual titles, tables, matrices and background colours), it has not 
gone unnoticed that the functionality was difficult to find.  Therefore, this 
update sees the entry point into the conditional formatting dialog made 

“more discoverable”.  Now, to access the dialog, simply click the fx button 
to the right of the object you would like to format.

For example, consider the ‘Visual title text’ option in the Formatting pane:

With the May release of Power BI Desktop, you can now curate featured 
tables to be referenced in Excel (Insider or Beta build).  This can help you 
easily link your Excel sheets with authoritative enterprise data.

In Excel’s data types gallery, you will be able to find data from featured 
tables in Power BI datasets,  For example, you can feature data on 
Customers, Product and Suppliers:

Clicking the fx button will bring up the ‘Conditional formatting’ dialog.  After applying a conditional formatting rule, the input field should now look 
like this:

Since the title text is no longer static, the input box has been replaced by a button taking you back into the conditional formatting dialog.  The eraser 
button on the right clears the conditional formatting rules you have set on the object.

Improved discoverability for conditional formatting

Curate featured tables for Excel (Preview)
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Additionally, by using Power BI’s certified and promoted datasets 
capabilities, you can enable members of your organisation to find and 
use relevant / refreshable data to assist in decision-making.  

In the example below, the ‘Let’s Stop N Shop’ cell is linked to curated, 
organisational data from Power BI, so you can find the contact information 
for the owner of the store right within your spreadsheet, viz.

To curate a featured table in Power BI Desktop, you will need to first turn on the Preview switch by going to File -> Options and Settings -> Options 
-> Preview features and selecting ‘Featured tables’:

In the model view of Desktop, you can then pick the table that you want to be a featured table to use in other products like Excel.  You can do so by 
selecting the table and setting the ‘Is Featured’ table toggle to Yes:
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You will then need to use the ‘Set up this featured table’ dialog to provide the required fields in the table.

A featured table must have a description, a row label and a key column:

	 •	 the ‘Row label’ field value is used in Excel so users can easily 		
		  identify the row.  It appears as the cell value for a linked cell, in the 	
		  ‘Data selector’ pane and in the Information card
	 •	 the ‘Key column’ field value provides the unique ID for the row.  	
		  This enables Excel to link a cell to a specific row in the table.

For the last point, you will need to publish the dataset to the Power 
BI Service.  After you publish or import the dataset to the Service, the 
featured table is displayed in Excel’s data types gallery.

Excel caches the list of data types, so you’ll need to restart Excel to 
see newly published featured tables.  Note that some datasets are not 
supported in the Preview; featured tables defined in those datasets 
won’t appear in Excel.

If you’re a Power BI administrator, you can control who in the organisation 
may use featured tables in the Excel data types gallery.  In your tenant 
settings, you can find the control to ‘Allow connections to featured 
tables’:
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Note that if the ‘Export data tenant’ setting is set to Disabled, connections to featured tables are also disabled.

Another new feature that will help optimise the Filter pane for query 
reduction by applying all filter changes at once.  Previously, you had two 
options for filter queries: 
	 1.	apply basic filters instantly (the default option) or 
	 2.	add an apply button to each basic filter. 

The first option, to apply the basic filter instantly, was ideal for those who 
prefer instant interactivity over query reduction.  Then, the second option, 
add an apply button to each filter card, optimised for query reduction 

instead.  However, it required an additional click every time you needed 
to apply a filter.

Now, Microsoft has added a new option for you to add a single apply 
button to the Filter pane, essentially, allowing you and your end users to 
apply all filter modifications at once.  This capability will be useful if you 
want to defer when to apply filter changes, so you only have to wait once 
after you are ready to apply any filter changes to the report or visuals.

Note that you can set this this feature at a report-level; however, the 
feature will be off by default.  You may turn on this new option in Power 
BI Desktop by going to File -> Options and settings -> Options -> Query 

reduction -> Filters and selecting the option to ‘Add a single Apply button 
to the filter pane to apply changes at once (preview)’.

Apply all filters (Preview)
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Currently, the formatting options for the ‘Apply’ text for the button are controlled by the following settings in the Filter pane section of the Format pane:

	 •	 Font and icon color (controls text color)
	 •	 Header text size (controls text size)
	 •	 Font family (controls font).
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Previously mentioned was the capability to have page refresh for DirectQuery sources based on a detected change instead of a fixed refresh interval.  
This update adds the ability to improve and optimise the performance of your change detection measure through:

	 •	 change detection simulation in Desktop
	 •	 change detection queries in Performance Analyzer.

It’s important to highlight that to make change detection work on the Service, these restrictions will apply:

	 •	 this is a Premium only feature so you need to publish the report to a Premium workspace to enable it
	 •	 Power BI will respect the settings and minima defined by the capacity administrator, so if the feature is off, it won’t work.  Also, if the 		
		  frequency you set up is lower than the minimum set up by the administrator, Power BI will respect the capacity limits.

Like automatic page refresh, you can now preview the behaviour of your 
change detection measure in Power BI Desktop.  Previously, you had to 
do this in Power BI Service.  To access this simulation, just define your 
change detection measure and turn on page refresh with the ‘Change 
detection’ option turned on and you will be able to preview how the 

visuals in your report page refresh based on changes detected by the 
measure.  This will help you confirm that your change detection measure 
is behaving the way it’s supposed to and to troubleshoot any issues you 
might have with this new capability.

The Performance Analyzer has been helping users to improve their 
reports since May 2019.  Now, there is a new capability to analyse queries 
beyond visuals with change detection being the first of this type.  To see 
how your change detection measure is performing, you need to open the 
Performance Analyzer through the View tab in the Ribbon, click on start 
recording, and turn on change detection in the ‘Page refresh’ section in 

the ‘Page formatting’ pane.  Once you do, you will see the Performance 
Analyzer populate with information of all actions, including each run of 
the change detection measure.  You will also notice that this measure has 
its own section including time spent in the DAX query, the Direct query 
and other tasks.

Enhancements to change detection (Preview)

CHANGE DETECTION SIMULATION IN POWER BI DESKTOP

CHANGE DETECTION QUERIES IN PERFORMANCE ANALYZER

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

To use these new capabilities, you need to enable the ‘Automatic Page Refresh’ Preview:

Back in March, Microsoft released a Preview of a new action type for buttons: drill through.  As a recap, the new action type allowed you to 
contextually navigate to a drill through page.

With considerable valuable feedback provided, this new action type is now Generally Available.  As part of this release, Microsoft has now added the 
ability to:

	 •	 conditionally set the drill through destination for the button
	 •	 conditionally format the ToolTips for the enabled and disabled button state
	 •	 individually customise the formatting for the disabled state of the button.

Drill through button action is now Generally Available
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You can now use conditional formatting to set the drill through destination based on the output of a measure.  There are some scenarios where you 
might want the button’s drill through destination to be conditional:

	 •	 you only want to enable drill through to a page once a specific condition has been met, else the button is disabled.  For example, you want the 	
		  user to select a single product and a single store before they can drill through to the Market details page, else the button is disabled

	 •	 you want the button to support multiple drill through destinations based on the user’s selection(s).  For example, if you have multiple 	
	 	 destinations (e.g. Market details and Store details) that the user can drill through to, you can have the user select which destination they want 	
	 	 to drill through to before the button becomes enabled for that drill through destination

	 •	 you may also have interesting use cases for a hybrid scenario, to support both multiple drill through destinations and specific conditions, 	
	 	 where you want the button to be disabled.

For the first use case, where you want to keep the button disabled for additional conditions, you simply need to create a DAX measure that will 
output an empty string (“”) unless the condition has been met, then it should output the name of the drill through destination page.

Here’s an example DAX measure that requires a Store to be selected before the user can drill through on a Product to Store details page:

Destination logic = IF(SELECTEDVALUE(Store[Store], “”)==””, “”, “Store details”)

Once you have the measure created you can click the conditional formatting (fx) button:

CONDITIONALLY SET THE DRILL THROUGH DESTINATION

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

For the last step you just need to select the DAX measure you created as the field value for the destination:

Now, you will see the button is disabled, even when single product is selected, because the measure requires a single store to also be selected:

For the other common use case, where you want to support multiple destinations, you can start by creating a single-column table that has the 
names of the drill through destinations:

Note that Power BI uses an exact string match to set the drill through destination, so you will want to double check that the entered values exactly 
align with your drill through page names.

Once this is created, you can add it on the page as a single-select slicer:

If you need more vertical real estate, you can convert the slicer from vertical to horizontal orientation:
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Then for the destination input for the drill through action, you will need to click the conditional formatting (fx) button:

For the last part, you will then select the name of the column you created:

Then you will see that drill through button will only be enabled when a product and destination has been selected:

Alternatively, if you are interested in a hybrid of the 
two scenarios, you could create and reference a 
DAX measure if you want to add additional logic for 
the destination selection.

Here’s an example DAX measure that requires 
a Store to be selected before the user can drill 
through on a Product to any of drill through pages:

Destination logic = 
IF(SELECTEDVALUE(Store[Store], “”)==””, “”, 

SELECTEDVALUE(‘Table'[Select a destination]))

Then you would need to select the DAX measure 
you created as the field value for the destination.  
Therefore, in this example, the user would need to 
select a Product, Store and destination page before 
the drill through button would be enabled:
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Another improvement added is the ability to conditionally format the 
ToolTip for the drill through button when it is enabled or disabled.  This 
can be particularly useful if you have used conditional formatting to 

dynamically set the drill through destination and you want the ToolTip 
for the button state to be more informative based upon your end user’s 
selection.  Here are some examples:

Previously, the disabled state look and feel could only be controlled through the report’s theme.  Now, this update adds several new formatting 
options for the disabled state.

These formatting options include:

	 •	 button text controls: text, colour, padding, alignment, size and font family

	 •	 you may set the disabled state ToolTip to be prescriptive on a case-by-case basis using a custom measure.  For example, if you want the user 	
	 	 to select a single product and a single store before they can drill through to the Market Analysis page, you can create a measure with the 	
	 	 following logic:

	 	 	 o	 if neither a single product nor store is selected, the measure can return “Select a single product and CTRL + Click to also select single 	
				    store”
	 	 	 o	 if a single product has been selected but a single store has not been selected, the measure can return “CTRL + Click to also select a single 	
				    store”
	 •	 Similarly, you may set the enable state ToolTip to be specific to the user’s selection.  For example, if you want the user to know which product 	
	 	 and store the drill through page will be filtered to, you can create a measure that will return:
	 	 	 o	 “Click to drill through to [drill through page name] to see more details on sales for [product name] at [store name] stores.”

CONDITIONALLY FORMAT DISABLED AND ENABLED STATE TOOLTIPS

CUSTOMISE FORMATTING FOR THE DISABLED STATE

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

	 •	 button fill controls: colour, transparency, and a new fill image (more on this below)

	 •	 icon controls: shape, padding, alignment, line colour, transparency and weight
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	 •	 outline controls: colour, transparency, weight and round edges.

In March’s release, a built-in button action for page navigation was issued, which allowed you to quickly create entire navigation experiences, without 
having to use a single bookmark.  Now this update sees a couple of enhancements to the feature:

	 •	 conditionally set the navigation destination
	 •	 support for shapes and images.

You can now use conditional formatting to set the navigation destination based on the output of a measure.  This can be useful if you want to save on 
real estate by having a single button to navigate to different pages based on the user’s selection.

In order to create the example shown above, you can start by creating a single-column table that has the names of the navigation destinations:

Note that Power BI employs exact string match to set the navigation destination, so you will want to double check that the entered values exactly 
align with your page names.

Once this is created, you can add it on the page as a single-select slicer:

Enhancements to page navigation action

CONDITIONALLY SET THE NAVIGATION DESTINATION
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Then you will create a page navigation button and select the conditional formatting option for the destination:

For the last part, you will then select the name of the column you created:

Then you’ll see that based on the user’s selection the button can navigate to different pages.

Page navigation action is now supported for shapes and images, not just buttons.  Here’s an example using one of the built-in shapes:

SUPPORT FOR SHAPES AND IMAGES
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Here’s an example using an image:

From this update, all buttons now support fill images.  This can prove useful because you can now customise the look and feel of your button using fill 
images while also taking advantage of the built-in button states: default, on hover, on press and disabled (for drill through).

This month also sees a new formatting feature for all visuals: drop shadows.  Toggling this option on in the Formatting pane will display a shadow 
behind the border of your visual.

In the Shadow tab, you may customise the look and feel of each shadow.  You can choose between a number of presets, or adjust individual properties 
of the drop shadow with the Custom setting.

Shadow controls whether the shadow appears in or outside of the visual border.

Buttons now support fill images

Drop shadow support for visuals
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If you are using Custom settings, you will see several additional options:

	 •	 the Size controls the radius or thickness of the shadow
	 •	 Blur controls how gradually the shadow will fade into the background.  Keep in mind that this Blur extends beyond the range set by Size
	 •	 Angle controls where the shadow will show up.  The shadow will move clockwise.  In other words, zero (0) degrees is horizontal and to the 	
		  right; 90 degrees is vertically down
	 •	 Distance controls the shadow’s offset from the centre of the visual
	 •	 Transparency controls the Transparency of the shadow.

As warned in the introduction to this section, this update has officially moved over to the Modern Filter experience, meaning any reports with the old 
Filter pane have been automatically migrated to the new experience.

Filter pane migration
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Be sure to take advantage of all the new capabilities in the modern experience, including:
	 •	 Quick filter view

	 •	 lock or hide filters

	 •	 sort the filters (custom or alphabetical sort)

	 •	 rename filters

 	 •	 Theme and Formatting options
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	 •	 capture Filter pane state in a bookmark

	 •	 show / hide the Filter pane for the end user

	 •	 show / hide the Filter pane while editing

	 •	 allow / restrict changes to Filter type

	 •	 search for filters

Two of Power BI’s AI visuals will now work in Direct Query (DQ) mode:

	 •	Decomposition tree (Preview)
	 •	 Key influencers (Preview).

However, there are a couple of limitations to remember:

	 •	 DQ Query Parameters are not supported
	 •	Automatic page refresh is not supported.

Direct Query support for AI visuals
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The latest updates now allow the decomposition tree to support ToolTips.  You can add additional measures to the ToolTips option in the field well 
and have them appear when users hover on the data bars in the tree:

It’s now been announced that decomposition trees are now Generally Available.  As part of this release, there are several updates to the visual:

	 •	 conditional formatting: the decomposition tree now supports conditional formatting by a second measure

	 •	 drill through support: you may drill through on any node of the tree
	 •	 sort capabilities: you may sort the tree alphabetically or by the measure
	 •	 responsive design: the design of the tree has been improved to fit better into more compact spaces and on mobile.  When you resize the tree, 	
		  the layout changes to better fill the available space

Decomposition tree now supports ToolTips

Decomposition tree is now Generally Available

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

	 •	 cross-highlight support: the tree can now be cross-highlighted as well as cross-filtered
	 •	 accessibility: screen reader, keyboard navigation and high contrast mode are now supported for the decomposition tree
	 •	 improved behaviour for filtering out of the visual: selecting any node in the tree will now always results in a cross-filtering action (instead of 	
		  collapsing the tree)

	 •	 improved scrolling behaviour: when a user scrolls down a level in the tree, the path they selected will be retained (instead of automatically 	
		  collapsed)
	 •	 right-click menu options: you now have the ability to include and exclude datapoints as well as show as table
	 •	 pinning visuals to the dashboard: you may now pin a decomposition tree to your dashboard (without AI splits).

There are some new updates to Q&A:

	 •	 you can now suggest your own questions to help your end users
	 •	 Teach Q&A now supports measure conditions
	 •	 Q&A is now supported in Power BI datasets.

To get users of the Q&A visual started, Power BI automatically suggests 
some questions to start with.  This update adds the option to define 
your own questions to show up in the Q&A visual.  In the new ‘Suggest 

questions’ section in Q&A setup, you can create a list of questions to be 
shown in the Q&A visual.  The questions will show up in Q&A in the same 
order as they were created.

With Teach Q&A, you can add definitions to make Q&A work better with 
your data model.  For example, if you have a table with Customer and 
Total Spend columns, you could define that “high-spending customers” 
are customers that spend more than $100.  In the first release of Teach 
Q&A, you could only create definitions on columns.  This update adds 
support for measure conditions.  In the example above, this means that 

if “total spend” is a measure, calculating the sum of all sales for one 
customer, you can use that to define “high-spending customer” in the 
Teach Q&A experience.  You can also calculate the measure in the Q&A 
expression itself.  For example, if “profitable customers” are customers 
with at least 20 orders in the order column, you can define customers 
with “count of orders > 20” as profitable, etc. 

Q&A updates

SUGGEST QUESTIONS

TEACH Q&A NOW SUPPORTS MEASURE CONDITIONS
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You can now use Q&A when connected to a Power BI dataset.  When you 
are working on a PBIX file connected to a Power BI dataset, you can use 
add a Q&A visual to the canvas and ask questions.  Currently, this only 

supports direct usage of Q&A on Power BI datasets.  Q&A setup and the 
linguistic schema options are not yet accessible.

Q&A IS NOW SUPPORTED ON POWER BI DATASETS

The radar/polar chart (also known as radial chart, spider chart, web 
chart) by xViz may be used for visualising multivariate data similar to a 
parallel coordinates chart.  Radar charts are useful for showing outliers 

and commonality by comparing one or more categories across different 
variables.  For example, they may be used to compare product performance 
across various metrics like ease of use, aesthetics and durability.

The xViz radar/ polar chart delivers several important features posted on Power BI Ideas, specifically around axis scaling, data labels customisation 
and support for legends:

	 •	 3-in-1 chart: choose between radar, polar and radial chart
	 •	 10+ series options: display line, column, area, stacked and stacked percentage charts
	 •	 Advance data label customisation with support for totals display in case of stacked radial chart
	 •	 Axis customisation: automatically or manually set the axis minimum and maximum values
	 •	 Support for a legend
	 •	 Advance conditional formatting for visually highlighting outliers based on different rules
	 •	 Number formatting options to customise values based on various business scenarios
	 •	 Summary table: tabular view of data.

Radar/Polar chart by xViz
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Well, this one’s different.  Comicgen by Gramener adds comic characters whose emotion, pose and angle may be controlled by data.

You can also graph cause and frequency using a Pareto chart to understand the key drivers of a process.

The Growth Rate Combo Chart by Djeeni is a visual that 
displays the percentage difference between consecutive 
category values, with the base for comparison being the 
category on the left.  This visual may be useful to show 
metric growth rates over time:

Pareto charts are used to visualise the results or outcomes for any process in order to identify the specific factors driving or impeding an effective 
conclusion.

This visual may also be downloaded from AppSource.  

Users can show up to two Key Performance Indicators (KPIs) at a time.  
Each KPI can be visualised as an emotion (e.g. happy or sad) and a pose 
(e.g. Thumbs Up or Angry).  You can choose to keep the visual emotion or 

pose or have both static by selecting the appropriate emotion and pose 
from the visual settings.  Users can choose different comics: currently, it 
supports Dee and Dey.  

This visual may be downloaded from AppSource.  We look forward to your new Board Reports with interest.

Comicgen by Gramener

Pareto by sio2Graphs

Growth Rate Combo Chart by Djeeni
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Examples where it may be used: 

	 •	 show percentage change between two or more categories
	 •	 show percentage change between two or more time periods.

Key features include:

	 •	 Line or Column chart
	 •	 you may choose two or more categories / time periods to see the percentage change
	 •	 you may deselect categories or time periods
	 •	 hide or show Selection pane.

This is another visual you can download from AppSource.

Smart Filter Pro by OKViz is the premium version of Smart Filter.  It provides a compact slicer that applies filters in many different ways, including 
autocomplete and incremental search in a dropdown list.

Working with huge datasets and loading all data in memory can be very expensive.  In Smart Filter Pro you can use the Filter mode, which allows the 
querying of data by defining filter conditions.  This way, there are no limits on which elements in the column to filter.  You can write filters with a simple 
syntax and get instant results.

Its key features include:

	 •	 unlimited rows (the free version is limited the 30,000 rows)
	 •	 Filter mode
	 •	 copy / paste a list of items
	 •	 Autocomplete
	 •	 performance boost
	 •	 dropdown list customisation
	 •	 additional ToolTips
	 •	 Themes support
	 •	 enhanced observer mode
	 •	 Hierarchy mode
	 •	 Bookmarks support
	 •	 synchronise slicers.

In the Pro version, with the Autocomplete enabled, Smart Filter Pro works like a browser search bar, meaning when you start typing a few characters, the 
input box will autocomplete the word with the first result from underlying data:

Smart Filter Pro by OKViz
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The Filter mode supports textual fields, dates, and numbers.  For each 
Data Type, you can use specific operators such as less than (<)  or greater 
than (>) for numbers and dates, or quotation marks for strings.  You 

can hover over the question mark icon (?) in the visual to see various 
examples of the query syntax.

You can also choose how to connect the keywords.  Both AND and OR logical operators are available:

You can paste a long list of items (like SKUs) in Smart Filter Pro in filter mode.  This action applies the filter to the desired custom list in a very efficient 
way, giving instant results with hundreds of items pasted in the visual.

And guess where you can download it from..?  That’s right: AppSource.

You may have noticed Power Bi’s visualization (sic) icons have a new look:

New Visualization icons
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These new icons have a higher colour contrast to improve accessibility, and they are consistent with their counterpart icons that you may be familiar 
with in Excel.

You will see these new icons in both the Visualizations pane and in the ‘Personalize visuals’ experience:

Packed bubble chart by xViz is similar to a bubble chart ,except that the 
bubbles are tightly packed rather than spread over a grid of x and y-axes.

A single category and value field is all that is required to create the visual.  
The Category field defines the individual bubbles and value represent the 

bubble size.  You can enable interaction features like drill down, grouping 
or clustering by adding additional category fields.  Additionally, you may 
use conditional formatting to highlight the bubbles based on different 
business rules.

xViz has also released a new version (1.1.3) of the hierarchy filter that has 
been re-engineered to support many new features with a modern interface 
and wide range of enterprise hierarchy filter scenarios.  The hierarchical 
navigation, along with conditionally formatted value field, makes it simpler 
to understand the importance and performance of each node.

The xViz hierarchy filter caters to some of the most requested features 
by enterprises like search, unbalanced hierarchy support (hide blanks), 
formatting and interaction capability along with other additional features 
listed below:

Listed below are some of the frequently requested features from the Power BI community that are available with this new packed bubble chart:

	 •	 bubble clustering and grouping capability based on assigned legend field
	 •	 data label customisation: choose from different data label formats to display combinations of category, value and percentage of total
	 •	 word wrap and responsive text: enables easier readability of data labels
	 •	 advanced conditional formatting: visually highlights outliers based on different rules
	 •	 bubble size customisation: define the minimum or maximum bubble size
	 •	 drill down support
	 •	 number formatting: enables customisation of values based upon various business scenarios
	 •	 summary table: tabular view of data.

Packed bubble chart by xViz

Updates to hierarchy filter by xViz
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	 •	 ability to add value (measure) along with category
	 •	 support for measure filter
	 •	 conditional formatting: alert induced selection (text and background)
	 •	 search capability
	 •	 support for unbalanced hierarchies: hide blank categories and values
	 •	 single child display: customise tree structure with single child nodes
	 •	 context menu for runtime capabilities like expand / collapse all nodes,  
	 	 enable / disable different conditional formatting rules, and rearrange  
	 	 nodes on the fly
	 •	 node level formatting: top node, parent and child

	 •	 interaction customisation: on hover and on node selection
	 •	 display mode: list and dropdown
	 •	 single and multi-select options
	 •	 display child count
	 •	 hierarchy icon customisation: arrow, plus / minus
	 •	 default expand to a particular level
	 •	 appearance tab: customise filter look and feel
	 •	 column header for category and value.

The title says it all!

The Power Platform CoE StartKit provides a holistic view of the resource usage in your tenant, including environments, Power Apps apps, Power Automate 
flows, connectors, connection references, makers and audit logs.

Examples where you could use it include:

	 •	 detect who are the star app makers and which departments have organically discovered Power Apps and Power Automate
	 •	 dive deeper to see which resources (apps, flows) are using a specific connector.  This can help you perform risk assessments or identify users who 	
	 	 use Premium features
	 •	 analyse app usage by specifically tracking unique users and sessions of an app to identify spikes or popular apps
	 •	 discover what connectors and flows are used heavily throughout the tenant
	 •	 identify business important components based on who they are shared with and how often they are used to ensure they receive the support 	
	 	 needed.

Power Apps visual is now compatible with all languages supported in Power BI

Power Platform Center of Excellence StartKit
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To connect your data, follow these instructions to set up the StartKit CoE and make the data available:

	 •	 click Connect
	 •	 enter your Environment URL
	 •	 choose OAuth2 for the Authentication method and sign in.

AppSource again.

Download from AppSource.

Azure Cognitive Search is a cloud search service with built-in AI capabilities 
that enriches all types of information to easily identify and explore relevant 
content at scale.  Azure Cognitive Search allows you to store operation 
logs and service metrics from your search service into an Azure Storage 

account.  This Power BI template app specifically enables you to analyse 
those operation logs and metrics so that you can obtain better insights 
about your search service.  The Power BI app provides detailed metrics 
about queries, indexing requests, operations, and more.

You cannot take a step outside your front door before the world reminds 
you of the COVID-19 pandemic.  As healthcare providers and local 
governments work to slow the spread of the virus and ultimately save lives, 
it’s critical that these organisations are equipped with accurate information 

in a timely manner.  To help these organisations and individuals stay 
informed, several of Microsoft’s Power BI partners have created template 
apps tracking the COVID-19 pandemic, e.g.

After you download them, you can use them as is, personalise them or share them inside your organisation.  All the following template apps connect to 
anonymous data sources.

	 •	 COVID-19 US tracking
	 •	 COVID-19 daily cases
	 •	 COVID-19 global cases.

Azure Cognitive Search: analyze logs and metrics

COVID-19 Apps
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The Power BI team has created a solution that provides a report of COVID-19 metrics that local governments, organisations or any other Power BI user 
can use to publish up-to-date information to their communities or for themselves.

COVID-19 US TRACKING

For those of us who remember there are more countries in the world than the United States, this COVID-19 report, which was developed by Pragmatic 
Works, provides information on daily cases, recoveries and death rates by country and state / province from the Center of Disease Control (CDC) and 
John Hopkins University.

COVID-19 DAILY CASES

With DataChant’s latest template app, you may analyse COVID-19 
global cases in a daily refreshed report, which includes advanced time 
intelligence measures to offset all countries by the number of estimated 

active cases per capita since the first day that 100 cases were reported.  
You can also hit the play icon to see the animated progression over the 
last 30 days if you really want to scare (or reassure) yourself.

ANALYSE COVID-19 GLOBAL CASES
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DAX authoring will now default to using the standard DAX characters 
of comma (,) as the list separator and period (.) as the decimal symbol.  
Before this change, Power BI required you to type the list separator and 
decimal symbols defined by your machine’s Region settings.

Behind the scenes, Power BI would convert your localised DAX to the 
standard separators required by the AS engine before saving.  At times, this 

led to some confusion and made it hard for customers in different regions 
to easily share DAX snippets.  Therefore, as an improvement, Power BI now 
defaults to the standard DAX separators.  If you want to default back to 
the list separator and decimal symbols defined by your machine’s Region 
settings, you can find this DAX separators option under Options and 
settings -> Options -> Global -> Regional settings:

After the General Availability release of Query Diagnostics last month, 
Microsoft is continuing to enhance it.  This update brings you Query 
Diagnostics Options, which will allow you to configure your diagnostics and 
performance output for Query Diagnostics.

Power BI Desktop has added a new button to the Tools tab in the Power 
Query Editor Ribbon to let you configure Query Diagnostics.

When you click it, it will take you to the Diagnostics page in Options dialog, which will allow you to configure what kind of outputs you want when you 
run Query Diagnostics.  This will help minimise the number of tables you have to clean up.

List separator and decimal symbol will now default to the standard DAX separators

Enhancements to Query Diagnostics
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You’ll notice a new option there: Performance counters.  These are a new output for Query Diagnostics.  When you run Performance counters, every half 
second Power Query will take a snapshot of resource utilisation.  This isn’t useful for very fast queries but can be helpful for queries that use up a lot more 
resources.  Performance counters reuse the “Id” concept of Query diagnostics, as well as introducing a number of new columns:

	 •	 Processor Time
	 •	 Total Processor Time
	 •	 IO Data Bytes per Second
	 •	 Commit (Bytes)
	 •	 Working Set (Bytes).

You may now connect to dataflows in Direct Query (DQ) mode.  In order to 
get started, you will need to have the dataflow configured on a Premium 
workspace and you will need to ensure the enhanced compute property on 
the capacity is enabled.  With these two conditions met, when connecting 

to a dataflow inside Power BI Desktop, you will now be prompted if you 
wish to use import or Direct Query mode.

N.B. This feature is incompatible with the enhanced metadata Preview.  
Please turn this Preview off in order to use Dataflows with Direct Query.

Web by example now provides automatic recognition of tables by default.  Previously, this option was off by default, but it is now readily available from 
the Navigator dialog.

This update also adds Privacy Level partitions to Power BI.  These are the logical partitions used to isolate data for privacy when running queries.  You 
can find the option to turn on or off ‘Data privacy partitions’ in the Diagnostics menu for Power BI.  These query diagnostics reuse the ‘Id’ concept from 
previous diagnostics, with a number of new columns:

	 •	 Id: same as the id for the other query diagnostics results.  The integer part represents a single activity id, while the fractional part represents a 	
		  single evaluation
	 •	 Partition Key: corresponds to the query / step that is used as a firewall partition
	 •	 Firewall Group: categorisation that explains why this partition has to be evaluated separately, includes details on the privacy level of the partition
	 •	 Accessed Resources: list of resource paths of all the resources accessed by this partition, generally uniquely identifying a data source
	 •	 Partition Inputs: list of partition keys upon which the current partition depends (this could be used to build a graph)
	 •	 Expression: the expression that gets evaluated on top of the partition’s query / step.  In several cases it coincides with the query / step
	 •	 Start Time: time when evaluation started for this partition
	 •	 End Time: time when evaluation ended for this partition
	 •	 Duration: End Time – Start Time
	 •	 Exclusive Duration: if partitions are assumed to execute in a single thread, exclusive duration is the “real” duration that can be attributed to this 	
		  partition
	 •	 Exclusive duration %: Exclusive Duration as a percentage
	 •	 Diagnostics: this column only appears when the query diagnostics “Aggregated” or “Detailed” is also captured, allowing the user to correspond 	
		  between the two diagnostics outputs.

Automatically recognised tables via Web by example will save you time; 
instead of needing to go through the Extract tables using examples 
experience, users can pick from the automatically recognised tables on a 

given webpage.  However, users can also continue to go into the ‘Extract 
tables using examples’ experience to select different data as needed.

Direct Query on Dataflows

Web by example now automatically suggests tables by default

Enhancements to Query Diagnostics: Privacy Level partitions
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This Power BI update brings into beta the CDM Folder view for the Azure Data Lake Storage Gen2 connector.  This will allow you to select if you want to 
view content in your data lake as CDM entities.

Witivio is an enterprise chatbot platform for employees with a deep 
integration in Microsoft 365 and the Power Platform.  Without code, 
users can design and monitor chatbots for HR, IT Help Desk and 
change management.  With the Witivio Power BI connector, chatbot 

administrators can track the usage and the performance of their chatbots 
to build advanced analytics.

You can find this connector in the ‘Online services’ section of the ‘Get 
data’ dialog.

Linkar is a suite of components that facilitates efficient connectivity to 
MultiValue Databases.  Linkar SERVER works with almost all MultiValue 
Database platforms centralising connections and optimizing DBMS 
licence usage.  Client apps use Linkar CLIENT libraries to interact with the 
database through Linkar SERVER, with bindings for popular languages.  

Linkar Power BI connector allows easy integration with MultiValue 
Databases through the Linkar platform.

You can find this connector in the Database section of the ‘Get data’ 
dialog.

Webtrends Analytics is a Microsoft-preferred solution built from the 
ground up for measuring performance of your website or SharePoint 
environments.  The Webtrends Analytics Power BI data connector allows 
you to import your data into Power BI via Microsoft’s Data Extraction API 
(REST) with a simple point and click.  All reports on an individual profile 
are now available at once; no more limited report lists.  The date range 

options have been expanded to allow standard report periods as well as 
custom date ranges.  A customer account with Webtrends is required to 
use the connector.

You can find this connector in the ‘Online services’ section of the ‘Get 
data’ dialog.

The folder in the lake will be considered a CDM Folder and brought into the Navigator view if it has at least one of the manifest files with the following 
name patterns:

	 •	 *.manifest.cdm.json
	 •	 model.json
	 •	 odi.json.

You can see below how a CDM folder might be represented in the Navigator.

CDM Folder view for Azure Data Lake Storage Gen2

Witivio connector

Linkar connector

Webtrends connector
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When you re-publish a dataset from Power BI Desktop to the Service, 
you’ll get a message that summarises for you the potential impact, 
e.g. how many reports and dashboards are already built on top of this 
dataset, and in how many workspaces.  If you want to see more details, 

such as usage metrics and take action, you can click on the ‘View impact’ 
link.  This will take you to the Power BI Service where you will see the full, 
detailed analysis.

Somehow, I think normal service will resume and there will be more Power BI Desktop updates next month.

ProjectPlace lets you plan, collaborate and track progress of all projects 
and assignments in a user-friendly way.

This connector is supported by Planview as the preferred method 
of reporting on ProjectPlace moving forward.  Existing users of the 

ProjectPlace connector should consider rebuilding their reports on this 
new, Planview maintained, certified connector.

You can find this connector in the Other section of the ‘Get data’ dialog.

Shortcuts Business Insights connector

The Shortcuts Business Insights connector enables you to consume, read 
and analyse your data collected via your Shortcuts point of sale product 
of choice.  Gaining access to this data will enable you to realise business 
insights from your appointment, transactional, client, employee, product 

and service data.  These insights will allow you to better serve your 
customers and anticipate their needs, while growing your business.

You can find this connector in the Other section of the ‘Get data’ dialog.

Shortcuts Business Insights connector

Vessel Insight is a vessel (how did we guess?) to shore data infrastructure 
delivered as a service.  The service enables shipowners, operators and 
charterers to capture data from onboard systems such as propulsion, 
navigation, cargo or VDR, as well as alarm and engine management 
systems.  Vessel Insight aggregates and contextualises the data before 
transferring it to the cloud using the KONGSBERG Global Secure Network. 

The Vessel Insight Power BI connector makes it straightforward to 
integrate and combine vessel data with existing systems and streamline 
reporting and decision making.

You can find this connector in the Other section of the ‘Get data’ dialog.

Vessel Insights connector

Zoho Creator is a low-code cloud software which lets you create custom 
applications for your business.  Zoho Creator can collect data, automate 
business processes or workflows, analyse the data in reports and 
collaborate with your application users.  The Zoho Creator connector 

allows you to analyse data and share insights based off all data in Zoho 
Creator, aside from the pivot report.

You can find this connector in the ‘Online services’ section of the ‘Get data’ 
dialog.

Zoho Creator connector

As a dataset owner, you might want to understand how your dataset is 
being used within the workspace and in other workspaces.  With the 
dataset impact analysis, you can judge how carefully you need to be when 
making changes to your dataset.  For example, if your dataset is being used 

in multiple workspaces (that feed multiple applications), with hundreds of 
end users consuming its data, then you will want to provide the relevant 
contacts heads-up notification about changes that may impact their 
reports so they may take any necessary action.

Dataset impact analysis

Given the aforementioned global health concerns, Microsoft has changed 
its Dashboard in a Day (DIAD) program to accommodate online delivery.  
The events will be scheduled on Microsoft Teams instead of in person 
classrooms.  

But we know you will still come to SumProduct’s training – which has been 
available online for years (see https://www.sumproduct.com/courses and 
https://www.sumproduct.com/subscriptions for more details).

New instructor-led training

ProjectPlace lets you plan, collaborate and track progress of all projects 
and assignments in a user-friendly way.

This connector is supported by Planview as the preferred method 
of reporting on ProjectPlace moving forward.  Existing users of the 

ProjectPlace connector should consider rebuilding their reports on this 
new, Planview maintained, certified connector.

You can find this connector in the Other section of the ‘Get data’ dialog.

Planview ProjectPlace connector
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The A to Z of Excel Functions: ERROR.TYPE
This function returns a number corresponding to one of the error values in Microsoft Excel or returns the #N/A error if no error exists.  You can use 
ERROR.TYPE in an IF function to test for an error value and return a text string, such as a message, instead of the error value.

The ERROR.TYPE function employs the following syntax to operate:

ERROR.TYPE(error_value)

The ERROR.TYPE function has the following arguments:

	 •	 error_value: this is required and represents the error value whose identifying number you want to find.  Although error_value can be the 	
		  actual error value, it will usually be a reference to a cell containing a formula that you want to test.

Note the newbies, because Microsoft hasn’t.

Please see an example below: 
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The A to Z of Excel Functions: EUROCONVERT
If you use this function, then I suppose EUROCONVERT!  This function has several features:

	 •	 it converts a number to Euros
	 •	 it converts a number from Euros to a euro member currency
	 •	 it converts a number from one euro member currency to another by using the euro as an intermediary (triangulation). 

The currencies available for conversion are those of European Union (EU) members that have adopted the euro.  The function uses fixed conversion 
rates that are established by the EU.

If this function is not available, and returns the #NAME? error, install and load the Euro Currency Tools Add-in.  To install and load the Euro Currency 
Tools Add-in:

1.	 On the File tab, click Options, and then click Add-Ins
2.	 In the Manage list box, select Excel Add-ins, and then click Go
3.	 In the Add-Ins Available list, select the Euro Currency Tools box, and then click OK
4.	 If necessary, follow the instructions in the setup program.

The EUROCONVERT function employs the following syntax to operate:

EUROCONVERT(number, source, target, full_precision, triangulation_precision)

The EUROCONVERT function has the following arguments:

	 •	 number: this is required and represents the currency value you want to convert or a reference to a cell containing the value

	 •	 source: this is also required.  This is denoted by a three-letter string or reference to a cell containing the string, corresponding to the 		
		  International Organization for Standardization (ISO) code for the source currency.  The following currency codes are available in the 		
		  EUROCONVERT function:

	 •	 target: again, required.  This too is a three-letter string or cell reference, corresponding to the ISO code of the currency to which you want to 	
		  convert the number.  See the previous source table (above) for the ISO codes.
	 •	 full_precision: this is another required field.  This is a logical value (TRUE or FALSE), or an expression that evaluates to a value of TRUE or 	
		  FALSE, that specifies how to display the result:
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	 •	 the following table shows the currency specific rounding rules, i.e. how many decimal places Excel uses to calculate a currency's conversion 	
	 	 and display the result:

	 •	 triangulation_precision: this is also required.  This represents an integer greater than or equal to three (3) that specifies the number of 	
		  significant digits to be used for the intermediate euro value when converting between two euro member currencies.  If you omit this 		
		  argument, Excel does not round the intermediate euro value.  If you include this argument when converting from a euro member currency to 	
		  the euro, Excel calculates the intermediate euro value that could then be converted to a euro member currency.

It should be further noted that: 

	 •	 Excel truncates any trailing zeros in the return value
	 •	 if the source ISO code is the same as the target ISO code, Excel returns the original value of the number
	 •	 invalid parameters return #VALUE!
	 •	 this function does not apply a number format
	 •	 this function cannot be used in array formulae.

Please see the example below: 

Further observations: 

	 •	 these examples assume conversion rates of 1 euro = 6.55957 French francs and 1.95583 deutsche marks.  The EUROCONVERT function uses 	
		  the current rates established by the EU.  Microsoft will update the function if the rates change.  To get full information about the rules and the 	
		  rates currently in effect, see the European Commission publications about the euro
	 •	 The examples show the resulting value stored in the cell, not the formatted value
	 •	 In the sample spreadsheet, trailing zeroes are truncated.

More Excel Functions next month…

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Beat the Boredom Suggested Solution
Earlier in the newsletter, we published a set of data comparing original budgeted numbers with their reforecast counterparts, viz.

The challenge was to re-format this data for a typical management report:

Most analysts will come up with a solution akin to the following:

The problem is there is a different formula in each cell in the row.  That means plenty of opportunities to reference the wrong cell as well as making 
it impossible to copy the calculation across the row. 

The challenge was to create just one formula you could copy across this row that would achieve the same result.

Our suggestion is as follows:

Imagine your cursor is positioned in cell D4 (the cell with the red X in it): 

	 •	 to get to the January budget data, you would have to move one cell down and one column to the right
	 •	 to get to the January reforecast data, you would have to move two cells down and one column to the right
	 •	 to get to the January variance, you would have to move three cells down and one column to the right
	 •	 to get to the February budget data, you would have to move one cell down and two columns to the right
	 •	 etc.

That’s right; it’s a nice simple formula:

=OFFSET($D$4,MOD(COLUMNS($E13:E13)-1,COLUMNS($E$13:$G$13))+1,ROUNDUP(COLUMNS($E13:E13)/COLUMNS($E$13:$G$13),0))

I think that might need some explanation!  Let’s start with the principle and take a closer look at the source data:
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Do you see?  To get to any data in January, you have to move one column 
to the right; to get to any data in February you have to move two columns 
to the right, and so on.  To get to any budget number you have to move one 
row down; to get to any reforecast number you have to move two rows 

down; to get to any variance figure, you have to move three rows down.

There’s a function that can help us with this: OFFSET.  We could get a 
formula to work as follows:

We need the number of rows reference in the OFFSET function to go

1, 2, 3, 1, 2, 3, 1, 2, …

as the formula is copied across and we want the number of column references in the OFFSET function to go

1, 1, 1, 2, 2, 2, 3, 3, …

Using COLUMNS($E13:E13) as our counter (COLUMNS simply determines the number of columns in the cited range), we can generate both of these 
functions easily.

To generate the first sequence (1, 2, 3, 1, 2, 3, 1, 2, …), the MOD function works wonders:

=MOD(COLUMNS($E13:E13)-1,COLUMNS($E$13:$G$13))+1

This reverts to MOD(Counter-1,3)+1.  The COLUMNS function has been used to avoid both a counter and the hard-coded value of 3.  This is in accordance 
with our Best Practice modelling principles of Flexibility and Transparency.

The ROUNDUP(value,n) function rounds the amount value up to n decimal places (so zero will be to the next whole number or integer).  Therefore,

=ROUNDUP(COLUMNS($E13:E13)/COLUMNS($E$13:$G$13),0)

rounds 1/3, 2/3, 3/3, 4/3, … to the next whole number (1, 1, 1, 2, …).

Putting this all together gives us our horror formula

=OFFSET($D$4,MOD(COLUMNS($E13:E13)-1,COLUMNS($E$13:$G$13))+1,ROUNDUP(COLUMNS($E13:E13)/COLUMNS($E$13:$G$13),0))

once more.  

Next month we’ll consider partial derivatives of Non-Linear Diophantine Approximation Theory…

 

Upcoming SumProduct Training Courses - COVID-19 update

Location Course Date Duration

Online Power Pivot, Power Query and Power BI 22 - 24 Jun 2020 3 Days

Online Excel Tips and Tricks 6 Jul 2020 1 Day

Online Financial Modelling 8 - 9 Jul 2020 2 Days

Online Power Pivot, Power Query and Power BI 20 - 22 Jul 2020 3 Days

Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties. To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course. 

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from
http://www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month, we thought we would see 
whether you have adequate CTRL over your keyboard shortcuts.  Take a letter, Ms. Jones:

Keystroke What it does

CTRL + 0 Hide columns

CTRL + 1 Format cells

CTRL + 2 Bold (toggle)

CTRL + 3 Italic (toggle)

CTRL + 4 Underline (toggle)

CTRL + 5 Strikethrough (toggle)

CTRL + 6 Toggle Show, Hide and Show Placeholders for Objects

CTRL + 7 Excel 2003 and earlier: toggle Standard toolbar visibility

CTRL + 8 Toggle showing outline symbols

CTRL + 9 Hide row
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Location Course Date Duration

Online Excel Tips and Tricks 18 Aug 2020 1 Day

Online Financial Modelling 19 - 20 Aug 2020 2 Days

Online Power Pivot, Power Query and Power BI 7 - 9 Sep 2020 3 Days

Online Power Pivot, Power Query and Power BI 9 - 11 Nov 2020 3 Days

Online Excel Tips and Tricks 16 Nov 2020 1 Day

Online Financial Modelling 17 - 18 Nov 2020 2 Days

Online Power Pivot, Power Query and Power BI 14 - 16 Dec 2020 3 Days


